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OMKRING DENNE BRUGSANVISNING

Lees denne manuel fgr du burger instrumentet.

Denne manuel er gyldg for Otosure (fra version 58000 og Audibase version 5.5).

Dette product er lave af:
Amplivox Ltd
3800 Parkside, Solihull Parkway,
Birmingham Business Park, Birmingham,
West Midlands,
B37 7YG
www.amplivox.com

Hvis du har spgrgelsmal kan du kontakte:

Amplivox Ltd

3800 Parkside, Solihull Parkway,
Birmingham Business Park, Birmingham,
West Midlands,

B37 7YG

United Kingdom

Tel: +44 (0)1865 880846

hello@amplivox.com

c € 0123

EC |REP

DGS Diagnostics A/S
Audiometer Alle 1
5500 Middelfart, Denmark
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INTRODUKTION

1. INTRODUKTION

1.1. TAK

Tak for at du har kgbt en Amplivox audiometer. Otosure er et kompakt audiometer, der kan udfgre automatiske
screening tests relaterende til luftbaren audiometri, drevet af en computer (PC). Produktet er et seerdeles prisattraktivt
til nutidens sundhedsmiljger.

Otosure produktet anvendes sammen med Amplivox Audibase softwaren, der tillader elektronisk gemmefunktion af
optagne patientdata pa PC’en, samt mulighed for kategorisering, print og udveksling af disse data med andre PC
applikationer.

1.2. TILTANKT FORMAL MED PRODUKTET

Audiometer Otosure er designet til brug af praktiserende laeger, erhvervssundhedspersonale og
bgrnesundhedspersonale og er det ideelle audiometer til primare plejegrupper, skoler og industri. Audiometeret er
ikke beregnet til brug af hgrespecialister til at bestemme det fulde omfang af en patients hgretab.

1.3. KONTRAINDIKATIONER

Start altid en patientsession med at kontrollere det ydre gre og gregangen for abnormaliteter, inden den auditive test
pabegyndes. Test bgr ikke udfgres pa patienter, hvis der er forhold, der falder indenfor nedenstaende kategorier:

1. Ved stimuli af hgje toner til personer med hgj fglsomhed overfor hgje toner, kan dette udggre til falske
testresultater, da denne gruppe patienter vil respondere irreguleert til testene.
2. Har faet udfgrt gre relateret operation for nylig.

1.4. STANDARD OG VALGFRIT TILBEH@R

Forsendelsesdokumenterne viser, hvilke produktdele, der er blevet leveret med produktet, via de varenumre, der er
angivet pa dokumentet. Kontrollér, at dette er i overensstemmelse med det bestilte. Bemaerk i gvrigt, at det er disse
varenumre, der skal anvendes, nar der skal bestilles evt. reservedele. Varenumrene kan ogsa finds via Amplivox website
(www.amplivox.com). Instruktion til brug af tilbehgr, fglger altid tilbehgret.

STANDARD TILBEH@R

Otosure audiometer 8508019 Audiometrisk headset (DD45) 8509615
Patientsvarer knap 8011155 HBA audiometri hovedband 8010882
USB kabel B (2.0 m) 8011241 Opbevaringstaske 8004651
Kalibreringscertifikat USB med Audibase Software og 8510705 and
brugsanvisning 8510707

(OSHA)
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BESTILLING AF FORBRUGSVARER OG TILBEH@R

Audiocups (noise reducing earphone enclosures) 8010855 Headband (standard headphone) 8010840
Audiocup ear cushion 8010835  Earphone cushion 8010857
Audiocup headband 8507381  Earphones DD45 * 8010876
Audiocup headband cover 8010834  Headset lead 8010822
Booth Leads 851095

Tilbehgr markeret med * kraever kalibrering med de specifikke audiometer, det skal
bruges med. Forsgg ikke at bruge disse tilbehgr fgrend de er kalibrerert med det
specifikke audiometer. Ellers passer de to ting ikke sammen, og resultater vil blive
misvisende.

FORSIGTIG

Forsendelsespapirerne vil referere til det ovenstaende varenummer og billeder af delene, sammen med de relevante
varenumre, kan ses pa Amplivox’s hjemmeside (www.amplivox.com). Monteringsvejledning fglger med de bestilte dele.

1.5. ADVARSLER

| hele vejledningen har de anvendte advarsler, forsigtighedsbemaerkninger og meddelelser fglgende betydning:

ADVARSEL angiver en farlig situation, som hvis den ikke undgas, kan medfgre dgdsfald
ADVARSEL .
eller alvorlige personskader.

FORSIGTIG brugt sammen med sikkerhedsopmarksomhed symbolet angiver en farlig

FORSIGTIG situation, som hvis den ikke undgas, kan medfgre mindre eller moderat personskade.
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2. UDPAKNING OG INSTALLATION

2.1. UDPAKNING

Abn forsendelseskartonen og tag forsigtigt alt udstyr op ad kassen. kontrollér at indholdet svarer overens med den
modtagne ordrebekraeftelse, inklusiv al tilbehgr. Hvis noget ikke stemmer overens, kontakt da venligst Amplivox
customer support (+44 1865 880846; sales@amplivox.com). Hvis produktet er kgbt via distributgr, kontakt da venligst
din distributgr.

Opbevar venligst forsendelseskarton og emballagemateriale til senere brug, nar audiometeret skal kalibreres (arlig
basis). Derved sikres de bedste rammer for returnering af produktet til Amplivox i sin originale forsendelseskarton.

2.2. MZARKNING

Felgende anmaerkninger kan findes pa instrumentet eller netadapter:

Symbol Explanation

L ]
ﬂ Type B anvendt del — en anvendt del giver en hgjere grad af beskyttelse mod elektrisk stgd end

en Type B anvendt del, specielt med hensyn til det tilladte niveau af laekstrgm og hjselpestrgm.

Den anvendte del er greproppen.

@ DE Der henvises til brugsvejledningen WEEE (EU-direktiv)

Dette symbol henviser til brugen af hhv. hgjre / venstre headphones, patientsvareren og de
tilhgrende kabler.

E WEEE (EU-directive)

Dette symbol indicates at nar man gnsker af afskaffe produktet skal det ggres via
genbrugsstationer eller lign. sa produktet bliver genanvendt i sa hgj udstraakning som muligt.
Hvis dette ikke sker, kan produktet pavirke miljget negativt.

Regulation. TUV Product Service, Identification No. 0123 har godkendt og auditerer Igbende

C € CE-mzerket indikerer at Amplivox Ltd. imgdekommer kravene fra Annex Il fra Medical Device
kvalitetssystemet.

SN Serienummer.

Fremstillingsar.

Producent.

J| Al

iy

Opbevares tort .

)
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a Fugtighedsgraenser ved transport og opbevaring .
Sl
Jf Anbefalet temperatur ved transport og opbevaring .

M D Medicinsk udstyr.
Lomoiivo< JIEER

2.3. SIKKERHEDSFORANSTALTNINGER
2.3.1. GENERAL

Felgende sikkerhedsanvisninger skal fglges til enhver tid. De generelle sikkerhedsanvisninger for af elektriske apparater,
lige sa. Ved frafald af dette kan det fgre til skade pa apparatet og/eller skade pa operatgr eller patient.

Det er arbejdsgiverens ansvar at instruere de ansatte i sikker adfzerd pa arbejdspladsen, sa uforudsete haendelser
elimineres, indenfor den enkelte medarbejders arbejdsomrade.

Amplivox Ltd. er bekendt med at sikkerhedsregler og adfzerd varierer fra organisationer. Hvis der er en modsvarende
konflikter i forhold til de sikkerhedsregler, der er angivet i denne manual og de faktiske forhold pa arbejdsstedet for
brug af produktet, henholdes der til, at de mest strikse regler fglges.

Otosure ma kun bruges af sundhedsprofessionelle, der er kvalificerede i at udfgre

ADVARSEL audiometri malinger. Produktet er beregnet til kortvarig brug, som et veerktgj til
screening og diagnostik; Ingen kirurgisk eller medicinsk procedure bgr foretages
udelukkende pa baggrund af resultaterne fra dette instrument.

2.3.2. FORSIGTIG - GENERELT

FORSIGTIG

Hvis systemet ikke fungerer korrekt, ma du ikke betjene det, fgr alle ngdvendige reparationer er blevet foretaget, og
enheden testes og kalibreres for korrekt funktion i overensstemmelse med Amplivox Ltd. specifikationer.

Tab ikke enheden, og undga gvrig uhensigtsmaessig pavirkning af den. Hvis instrumentet beskadiges, skal det returneres
til producenten med henblik pa reparation og/eller kalibrering. Brug ikke instrumentet, hvis der er mistanke om
beskadigelse.

Dette produkt og dets komponenter er kun palidelige, nar det betjenes og vedligeholdes i overensstemmelse med
instruktionerne i denne vejledning, ledsagende etiketter og/eller indsatser. Man bgr ikke anvende et defekt produkt.
Segrg for, at alle tilslutninger til eksternt tiloehgr er sikret korrekt. Dele, der kan ga i stykker eller mangler eller som er
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synligt slidt, forvraenget eller beskidt, skal straks udskiftes med rene, originale reservedele fremstillet af eller tilgeengelig
fra Amplivox Ltd..

Udstyret ma ikke repareres af brugeren. Reparationer ma kun udfgres af en autoriseret servicerepraesentant. Ingen
2ndringer af udstyret tillades af andre end en kvalificeret Amplivox Ltd. -repraesentant. Modifikation af udstyret kan
veere farligt.

Amplivox Ltd. stiller efter anmodning kredslgbsdiagrammer, komponentstykliste, beskrivelser, kalibreringsinstruktioner
eller anden information til radighed, som autoriserede servicemedarbejdere kan fa brug for ved reparation af de dele
af instrumentet, som Amplivox Ltd. har bestemt kan repareres af servicemedarbejdere.

Ingen dele af udstyret ma serviceres eller vedligeholdes, mens det er i brug pa en patient.

Tilslut kun tilbehgr kgbt fra Amplivox Ltd. til instrumentet. Kun tilbehgr, der er angivet af Amplivox Ltd. som at veere
kompatibelt, ma forbindes til enheden.

2.3.3. MILU@MASSIGE FAKTORER

FORSIGTIG

Opbevaring udenfor temperaturomradet, der er angivet i afsnit 8, kan medfgre

L]
]
T J’ permanent skade pa instrumentet og dets tilbehgr.

Brug ikke enheden i naerheden af vaeske, der kan komme i kontakt med de elektroniske komponenter eller ledninger.
Hvis brugeren har mistanke om, at vaesker er kommet i kontakt med systemkomponenter eller tilbehgr, ma enheden
ikke bruges, fgr den er godkendt af en autoriseret servicetekniker.

Undlad at placere instrumentet teet pa enhver form for varmekilde og sgrg for tilstreekkelig plads omkring
instrumentet for at sikre korrekt ventilation.

2.3.4. ELEKTRISK OG ELEKTROSTATISK SIKKERHED

Fgrend service pabegyndes til indsaet-telefonerne, skal disse frakobles patienten.
ADVARSEL

Ror ikke kontakterne pa bagsiden af Otosuren og patienten samtidig. Der kan opsta
ADVARSEL .. . .
risiko for laekstrgm overfgrsel imellem patient og product, uforvarende.

Abn ikke instrumentet. Tilkald altid certificeret service personale.

Dette udstyr er tilteenkt at blive tilkoblet andet udstyr, omend det udggr et Medicinsk Elektrisk System i sig selv. Dette
eksterne udstyr, udggrende hhv. signal input, signal output eller andre forbindelser, skal overholde standarderne: IEC
60950-1 for IT udstyr og IEC 60601-series for medicinsk elektrisk udstyr. Yderligere skal alle forbindelser overholde
sikkerhedskravene angivet i IEC 60601-1, (edition 3.1), clause 16. Hvis forbindelsesudstyr ikke overholder leekage strgm
kravene i, IEC 60601-1, skal produktet holdes adskilt fra patienten med mindst 1.5 m afstand og en
separationstransformer, for at minimere laekagestromsspaendinger. Safremt der tilsluttes eksternt udstyr til signal input,
signal output eller andre forbindelse til produktet, har man dannet et medicinsk elektrisk system, og er derfor ansvarlig
for at sikre, at krav til et sddan, som skitseret herover, overholdes. Hvis i tvivl, kontakt din lokale Amplivox repraesentant.
Nar produktet er tilsluttet PC eller lignende enheder, veer da opmarksom p3, ikke at rgre PC og patient samtidig.
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For at isolere patienten i et eget miljg, anvendes en skilletrafo, der sikrer galvanisk adskillelse af patienten fra det
omgivende miljg. Dette benyttes iseer i netvaerksbaserede miljger. Krav til adskillelse er angievet i IEC 60601-1 clause 16
standarden.

2.3.5. ELEKTROMAGNETISK KOMPATIBILITET (EMC)

Selvom instrumentet opfylder de relevante EMC-krav, bgr der tages forholdsregler til
at undga ungdig eksponering for elektromagnetiske felter, fx. fra mobiltelefoner, osv.
Hvis apparatet bruges i neerheden af andet udstyr, skal der sgrges for, at der ikke opstar
gensidig forstyrrelse. Se ogsa bilaget vedrgrende EMC.

FORSIGTIG

2.3.6. EKSPLOSIONSFARER

Ma ikke anvendes i neerheden af brandfarlige anaestetika eller andre gasser.
ADVARSEL

Brug IKKE i neerheden af brandfarlige gasblandinger. Brugere bgr overveje muligheden
for eksplosioner eller brand ved brug af denne enhed i naerheden af brandfarlige,
anaestetiske gasser.

Brug IKKE instrumentet i et steerkt iltberiget miljg, som fx. et hyperbarisk kammer, ilttelt
mv.

2.3.7. MALESIKKERHED

For at garantere at Otosure produktet fungerer, som det skal, skal produktet kontrolleres og kalibreres mindst én gang
per ar. Transducerne (hgjtalerenheder i dette tilfeelde) er kalibrerede specifikt til det enkelte apparat. Ved udskiftning
af disse vil rekalibrering veere ngdvendig.

Service og kalibrering skal udfgres af en autoriseret service tekniker. Hvis disse arlige internvaller ikke overholds, jf. EU
Medical Device Regulation (MDR) og andre lokale pakraevede regulativer, garantibestemmelse kan ikke blive opretholdt.

Brug af ikke-kalibreret udstyr kan fgre til forkerte testresultater og er ikke tilradeligt.

2.3.8. ANDRE FORHOLD

Notér venligst felgende: tilslut IKKE Otosure hardware delen til en computer fgrend softwaren er blevet installeret.
Placér ikke apparatet i naerheden af en varmekilde.

Uduvis forsigtig handtering af hovedsaet og patientsvarer til enhver tid, da grov handtering, s som eks. fald pa harde
overflader kan resultere i skader pa produkterne.

Inden for Den Europaeiske Union er det ulovligt at bortskaffe elektrisk og elektronisk affald som
usorteret husholdningsaffald. Elektrisk og elektronisk affald kan indeholde farlige stoffer, og skal
derfor kasseres separat. Disse produkter vil blive markeret med en overstreget affaldsspand pa hjul,
som vist i venstre side. Samarbejde med brugeren er vigtig for at sikre et hgjt niveau af genbrug og
genvinding af elektrisk og elektronisk affald. Undladelse af at genindvinde affaldsprodukter pa
passende made kan udggre en fare for miljget og dermed for menneskers sundhed.

Uden for EU bgr lokale bestemmelser fglges med hensyn til bortskaffelse af enheden, nar den er udtjent.
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2.3.9. BRUG AF PRODUKTET EFTER TRANSPORT ELLER OPBEVARING

Venligst kontrollér at produktet fungerer korrekt fgr brug. Hvis produktet har veeret opbevaret i et koldt miljg, lad da
produktet afklimatisere fgrend det tages i brug igen. Tiden afhaenger af omstandighederne. Evt. Kondensdannelse pa
apparatet kan begraenses ved at opbevare produktet i den originale indpakning til produktet. Hvis produktet har vaeret
opbevaret under varmere forhold, end de, det benyttes i, er der ikke nogen yderligere foretag, der skal udfgres. Det er
god praksis at indfgre rutinemaessige check af produktets funktionalitet inden enhver ibrugtagen for at sikre korrekte
maleforhold til enhver tid.

2.4. FORBINDELSER

Alle relevante tilbehgr-terminaler og forbindelser er markeret for at sikre korrekt identifikation og forbindelsesflader
pa fglgende made:

Stick Type Farvekode Tilsluttet part
6.3mm jack Bla Air conduction headset (Left) *
6.3mm jack Red Air conduction headset (Right) *
6.3mm jack Sport Patient Svarer knap *
USB Connector N/a Computer (via USB port)

Venligst noter: For tilsluttede dele, der er markeret med * : Tilslut kun det medfglgende tilbehgr fra Amplivox. Det
er kun det tilbehgr, der er testet til brug med Otosure Screening Audiometer for compliance med standarderne IEC
60601-1 and IEC 60601-1-2. Al anden tilbehgr kompromiterer denne compliance. Se Appendix 2 for andre stik end de
ovenfor angivne.

2.5. HARDWARE INSTALLATION

Der refereres til afsnit 11 for vigtig information vedr. tilslutning af ikke-medicinsk elektrisk udstyr til medicinsk
elektrisk udstyr .

Audiometeret forsynes og kontrolleres via en computer (PC) og anvender den medfglgende software til formalet.
Derfor skal denne software installeres fgrend audiometeret tilsluttes PC’en.

Alle andre tilslutninger skal ggres, inden audiometeret tilsluttes PC’en.

Der medfglger et USB kabel til Otosuren. Dette skal benyttes til tilslutte enheden til PC'en. USB porten pa PC siden skal
veere en version 1.0 eller 2.0. Tilslut headset og patientsvarer responsenheden til Otosure fgrst, for derefter at tilslutte
Otosure til PC’'en. Det kan tage et par minutter for PC’en af connecte til produktet fgrste gang.

l; Notér venligst felgende: Se afsnit 4 for installation af software og drivers, hvordan man tilslutter apparatet til
PC’en fgrste gang, og hvordan man gennemfgrer et basischeck af apparatets funktionalitet inden brug.
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3. INSTALLERING AF SOFTWARE & OPERATIONEL CHECK

3.1. GENERELT

Dette afsnit beskriver procedure for at installere Otosure software og tilhgrende drivers, ligeledes hvordan man
gennemfgrer et basischeck af apparatets funktionalitet inden brug.

3.2. INSTALLATION

Installationen foregar i to steps:
1. Installér den medfglgende Otosure software pa PC’en
2. Installér de medfglgende device drivers (findes pa USB stick)

Step 1: Installation af Amplivox Otosure Software
Installeringen af Otosure software sker som en del af installationen af Audibase. Venligst se Audibase5.x burger guide
for step by step installationsprocessen.

Step 2: Installation af USB Device Drivers
Venligst se “D-0115682" Guide to Installing Amplivox USB Drivers

3.3. AFINSTALLERING AF OTOSURE PROGRAM

Afinstallering af Otosure programmet ggres ved at finde filen “Otosure.exe” (brug sgg funktionen i Windows
startknappen. Ved at slette denne fil fjernes programmet. Der er ikke behov for at bruge “Add or Remove Programs”
funktionen i Windows.

l; Notér venligst: Hvis der er behov for mere information vedrgrende afinstallation af programmet, henvises der til
Audibase5.x user guide.

3.4. OPERATIONELT CHECK

Tilslut hovedtelefonen og patientsvareren til Otosure audiometeret og tilslut Otosure audiometer til PC’'en via det
medfglgende USB kabel. Start Audibase applikationen pa PC'en og tast ny patient data ind (evt. se Audibase burger
manualen).

{) Start en test ved at bruge Launch Test button i Audibase toolbaren
I

F

,ilﬂ'll Luk evt. dialog bokse i Otosure vinduet og vaelg Manual Test optionen:

Flyt musepilen hen over “Present” ikonet i Otosure vinduet og check at der er lyd i hovedtelefonen. Brug piletasterne
pa PC tastaturet for at eendre lydstyrke og frekvensband af tonerne. Brug “L” and “R” tasterne for at skifte mellem
hgjtalerne pa hovedtelefonen.

Tryk op patient svarer tasten for at checke at “Response” ikonet i Otosure vinduet sendrer farve, fra merk gren til lys
gren (nar tasten er trykket ned), og vice versa, nar tasten slippes igen.
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o

Ovenstdende giver et basis check af audiometrets funktioner Nar Otosure vinduet lukkes, husk da at trykke pa “Edit >
Cancel Insert/Edit” eller cancel toolbar button i Audibase for at slette test sekvensen.
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4.BRUG AF OTOSURE

4.1. FORBEREDENDE INSTALLATION

Tilslut headset og patientsvarer responsenheden til Otosure fgrst, for derefter at tilslutte Otosure til PC’en. Det kan tage
et par minutter for PC’en af connecte til produktet fgrste gang.

4.2. STARTING THE SOFTWARE

Start Audibase applikationen. Veelg enten at oprette en ny patient, eller tilga data pa en eksisterende patient.

[ Brug den venstre museknap til at starte test ikonet i Audibase toolbaren.
e

Alternativt, kan “Test > Launch Test” drop-down menu anvendes i toppen af Audibase vinduet.

Et nyt vindue vil abne i softwaren. Hvis en patient har mere end et szt data gemt i Audibase vil det seneste audiogram
blive vist i Otosure vinduet.

Serienummeret og kalibreringsdato for det tilsluttede Otosure audiometer kan altid ses i bunden til hgjre hjgrne
(sammen med den valgte test type).

Den seneste test type fremgar altid som det fgrste man ser igen.

rRun Test? o @ For at fortseette med same specifikationer som sidst, klik da blot pa “Start
test”.

Run test, or modify test settings?
Hvis man gnsker at udfgre manual test eller endre testspecifikationer,
trykkes pa “Modify” knappen.

i Starttest Modify I

4.3. TILGANGELIGE TEST MODES
4.3.1. MANUEL TEST

Dette tillader operatgren at benytte Otosure til at optage hgretaerskler vha. computerens keyboard og mus.
Resultaterne kan derefter overfgres til Audibase.

4.3.2. COMPUTER TESTING

Denne metode beror pa automatisk audiometri, der baserer sig pa Hughson and Westlake metodikken, og fordrer at
instrumentet udfgrer testen automatisk for operatgren. Lydniveaet haeves Igbende med 5 dB indtil der affgdes et
respons fra patienten og ligeledes seenkes med 10 dB, indtil der ikke la&engere kommer et respons fra patienten. Denne
proces gentages indtil de givne kriterier sat for testen er opfyldt — de valgte frekvenser, indtil de er gennemfgrt pa
begge grer. Apparatet gemmer selv resultaterne undervejs.

Udover multifrekvenser, er det ogsa muligt at kgre enkeltfrekvenser og tilfgje disse i det efterfglgende overordnede
audiogram for patienten. Dette kan veere fordelagtigt i situationer, hvor én frekvens ser problematisk ud.
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4.3.3. MIXED TESTING

Dette anvendes typisk, nar en automatisk test har vaeret ude af stand til at afkode en eller flere hgretaerskler. | det
tilfeelde kan det veere fordelagtigt at tilfgje disse manglende niveauer til den samlede test efterfglgende.

4.4. GENVEIJSTASTER

=

T

starter den valgte automatiske test

g

L))

| i17°°

Velger Computer test type

Velger Manuel test mode

Viser test detaljer

Velger audiogram visningsmuligheder

Praesenterer en test tone i Manuel test mode nar musen flyttes hen over knappen. Der er ikke
behov for at trykke pa musetasterne.

Nar tonen praesenteres skifter ikonet farve til dette format.

Ij Notér venligst: Ovenstdende fungerer ogsa saledes, nar der kgres i automat test mode,
omend det ingen effect har pa den automatiske test i gvrigt.

Patient respons indikator. Dette vises, nar patienten IKKE har givet en respons.

)))? Patient respons indikator. Dette vises, nar patienten HAR givet en respons.

4.5. GENVEJE PCKEYBOARD OG MUS

Keyboard, “L” key:
Keyboard, “R” key:
Keyboard, 0 key:
Keyboard, d key:

Keyboard, « key:

Keyboard, — key:
Mouse, pointer:
Mouse, left button:

Mouse, right button:

vaelger det venstre gre i Manuel test mode
vaelger det hgjre gre i Manuel test mode
gger lydniveauet i Manuel test mode
senker lydniveauet i Manuel test mode
veelger en lavere tone frekvens i Manuel test mode
vaelger en hgjere tone frekvens i Manuel test mode
afspiller test tone nar flyttes henover present ikonet i Manuel test mode
vaelger Windows-based options som normal
plotter en hgretaerskel i manuel test mode
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4.6. MANUEL TESTING

Klik Manual test button a0 (knappen vil lyse op)

Alternativt brug “Test > Manual” via drop-down menuen i toppen af til Otosure vinduet, og den fglgende skeerm
kommer frem:

8 mptvos s ™ o )

Ext Test View Options Pause About

€«  wWER ENA
_ Lo |
Previous.
| || LI | I I I [ | Il | I I
Current
| | I I | I I I I I I | I | | I | |
125 250 500 1K K5 2% 3K 4K 6K 8K dBHL 125 250 500 1K K5 2% 3K & 6K 8K

--------- -10

0
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20

+ 30

40

50

60

70

80

90

100

110

120

LEFT RIGHT
idie | 1KHz 30 dBHL | | Connected to 1,Cal date 27/3/2012 | | Manual

Cursoren placeret i den venstre del af audiogrammet indikerer den nuvaerende frekvens og dBHL vaerdi (ses ogsa
nederst i center omradet af skaermen)

Flyt musen henover “Present” ikonet - og en tone vil blive praesenteret ud fra de given parametre i den

venstre hovedtelefon. Nar tonen praesenteres skifter knappes farve til I ‘}): .
Hvis patienten trykker pa patient response knappen, a&ndres “Response” ikonet fra mgrk grgn til lys

gron &
For at endre niveauet af den praesenterede tone, anvendes piletasterne T og { p& PCen.

Nar man er sikker p3, at et response er bekraeftet, kan man plotte det pa skaermen via klik pa hgjre musetast. Den
nummeriske veerdi pa hgreteersklen tilfgjes derefter i tekstboksen ovenover audiogrammet. Hvis man har lavet en fejl,
korrigerer man blot ved at indsaette en ny hgretaerskel pa den gaeldende frekvens. Den forrige veaerdi overskrives
dermed.

For at slette alle hgretaerskler fra audiogrammet trykkes: “Test > Clear readings ...” , tryk pa drop-down menuen og
veelg de vaerdier, der skal slettes.

For at aendre frekvens pa den praesenterede tone, anvendes piletasterne <— og — pa PC keyboardet. Fortsaet med at
plotte hgretaerskler indtil alle frekvenser er testet.
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For at veelge d@re, trykkes enten “R” for hgjre eller “L” for venstre pa PC keyboardet.

Brug de ovennavnte kontroller for til at opbygge dit audiogram for en patient. Nar faerdig, klik pa “Exit” | toppen af
Otosure vinduet og bekrzeft exit af Otosure. Otosure vinduet lukker dermed og Audibase vinduet vil vise det samlede
test resultat. Se Audibase burger manualen for yderligere muligheder. Notér venligst at resultaterne skal gemmes i
Audibase for at blive gemt i databasen.

4.7. COMPUTER TESTING

Klink pa Computer test knappen (bliver highlighted ved aktivering).

T

Alternativt, benyt “Test > Computer” drop-down menuen i toppen af Otosure vinduet, hvorefter en skaerm vises, dog
uden “Present” ikonet og cursoren.

For at kgre en fuld Computer test pa begge grer, klikkes blot “Run selected test” button.

&

Alternativt kan man benytte “Test” drop-down menuen for enten at vaelge en fuld test eller en afgraenset deltest. (for
example begraenset til et gre).

Computer testen vil kgre iht. de valgte test kriterier. Test status er vist nederst til venstre i Otosure vinduet. “Present”
og “Response” ikonet vil Igbende blive vist og skifte status (mgrk / lys gren) som fglge af fremdriften i testen.

For at se detaljer i testforlgbet, veelg “Show test detail” knappen:

|

Alternativt, benyt “View > Detai

|n

i drop-down menuen.

For at se audiogram hgretzersklerne, veelg “Show Audiogram” knappen:

™)

Alternativelt, benyt “View > Audiogram” i drop-down menuen.

Safremt alle frekvenser gnskes testet, er raekkefglgen, som fglger: 1kHz, 1.5kHz, 2kHz, 3kHz, 4kHz, 6kHz, 8kHz, 500Hz,
250Hz og 125Hz.

Patient kan respondere pa den praesenterede tone, fra den praesenteres og indtil den naeste starter (ca 2.3 sek.
maksimum). Hvis et response ggres indenfor tidsrammen, laegges en forsinkelse ind til den efterfglgende tone.

Nar en test er succesfuldt gennemfgrt, vil den fglgende dialog boks vises:

F y
Automatic Test Finished g

Test sequence completed sucessfull
Continue further testing, or accept results?

Nar en test ikke er succesfuldt gennemfgrt, vil den fglgende dialog boks vises:
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F A
Automatic Test Finished M

Test sequence complate with emars
Continue further testing, or accept results?

For at accepterere de fundne resultater og overfgre dem til Audibase klikkes pa “Accept” knappen. Dermed lukkes
Otosure vinduet og Audibase vinduet vises i stedet. Se Audibase burger manualen for yderligere muligheder. Notér
venligst at resultaterne skal gemmes i Audibase for at blive gemt i databasen.

For at fortseette med at teste, klik pa “Continue”. Dermed lukker dialog boksen og man kan fortsaette med at teste.

4.8. ENKELT FREKVENS TESTING

| computer test mode er det muligt at teste blot en enkelt frekvens. F.eks. kan operatgren have opdaget at patienten
ikke responderer konsekvent op en bestemt frekvens, eller at den automatiske test var ude af stand til at bestemme
en hgreteerskelsveerdi pa en bestemt frekvens.

Brug “Test > One freq. test” drop-down menuen til at veelge den frekvens, der gnskes for det enkelte gre. Ved at klikke
pa den specifikke frekvens, overskrives den allerede eksisterende vaerdi pa frekvensen i audiogrammet. Ved slut af
testen trykkes enten “Continue” eller “Accept”.

4.9. MIXED-MODE TESTING

Dette tillader at man kan feerdigggre sit audiogram ved at udfgre nogle tilfgjede frekvenstests. Eks. hvis at den
automatiske test var ude af stand til at bestemme en hgretaerskelsvaerdi pa en bestemt frekvens.

Teksten “Mixed” vil fremga nederst til hgjre i Otosure vinduet.



INDSTILLINGER VIA SET-UP MENUEN

5.INDSTILLINGER VIA SET-UP MENUEN

5.1. GENERELT

Otosure softwaren gemmer automatisk de seneste test konfigurationer og vil anvende det i enhver efterfglgende test.
Dertil kommer et antal mulige valgmuligheder for setup, modificering og control af en test. Disse er navnt herunder.
Venligst se Otosure Softwaren.

5.2. MENU KOMMANDOER

Exit: Dette lukker det aktuelle Otosure vindue og overfgrer automatisk testresultaterne til Audibase, safremt brugeren
tillader dette som ”“confirmation” i programmet.

Test: Dette medfgrer adgang til en raekke muligheder:
e Run full test (tester hvert gre via den aktuelt valgte automatiske test type)
o Left test (tester det venstre gre via den aktuelt valgte automatiske test type)
e Right test (tester det hgjre gre via den aktuelt valgte automatiske test type)
e One freg. test (tester det valgte gre og frekvenskombination via den aktuelt valgte automatiske test type)
e  Stop test (mulighed for at stoppe den igangvaerende test. Testen fortsaetter indtil patienten responderer én
gang. Derefter gemmes fundne hgretaerskelsvaerdier.
e (Clear readings (sletter alle audiogram og hgretarskels data, eller data for venstre eller hgjre gre)
e  Computer (seetter Computer til at veere den aktuelt valgte automatiske test type)
e  Manual (seetter audiometeret i manuel test mode)

View: dette tillader enten at se test “Detail” (grafisk visning at de prasenterede toner og tilhgrende patientsvar), eller
Audiogrammet

Options: Dette dbner dialogboksen, der giver adgang til fglgende muligheder:

o Der forefindes video pd youtube ang. Denne function

e Frequencies (frekvenser) — inkluder eller ekskluder: 125Hz, 250Hz, 1.5kHz or 8kHz til/fra test sekvensen
e  Computer test — kontrollerne tillader:

o Valg af enten 2 ud af 3 eller 3 ud 5 konsekvente svar som vaerende valide ift.
hgreteerskelfastsaettelse.

o Aten gentest af 1kHz frekvensen bortfalder.

e Tone response — kontrollér hvilken handling, der skal foretages, safremt der er opstaet en fejl:

o Antallet af gange en frekvens er gentaget hvis eks. en fejltesting forekommer (eks. patient trykker
hurtigt mange gange), da skal det noteres som fejl, enten ved at trykke: skip the frequency eller
pausér testen

e  Start level — specificér et start niveau for enten 20dBHL, 30 dBHL eller 40 dBHL for en test, og for alle
frekvenser fra 1kHz og derunder for en Computer test

e  Start with familiarisation — start med en prgvetest ved 1kHz fgrend den rigtige test opstartes.

e Beep on finish — Nar testen afsluttes afspilles en kort lille bip-tone for operatgren.

Pause: Indsaetter straks en pause i testforlgbet og viser de yderligere tilgeengelige muligheder i testforlgbet, eks.: stop
den igangvaerende test, gentest den seneste frekvens, eller spring over den nuvaerende frekvens og hop til den naeste.
Hvis testen afsluttes gemmes resultaterne.

About: Viser version af den installerede Otosure software pa PC’en og support email addresse
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6. FEJLFINDING

6.1. GENERELT

Otosure produktet er designet til at vaere nemt for brugeren at tilga, og hvis instruktionerne i denne manual fglges,
bar hgretest kunne udfgres uproblematisk. Produktet er designet saledes at det skal kunne identificere en raekke fejl i
eventuelle testresultater, safremt de optraeder. Disse er beskrevet herunder.

6.2. NO INSTRUMENT FOUND

Hvis audiometeret ikke kan tilsluttes computeren, vil Otosure softwaren ikke starte og den fglgende dialog boks vises:

—
Communication

Instrument not found

Error 2 type d

Klik OK for at returnere til Audibase.

Brug “Edit > Cancel Insert/Edit” optionen eller cancel toolbar knappen for at afbryde insert operationen. Prgv igen at
tilslutte Otosure, hvorved Audibase operationerne kan fuldfgres.

6.3. INGEN RESPONS FRA PATIENTEN

Hvis audiometeret ikke detekterer en respons undervejs i testforlgbet fra patienten vil den automatiske test
automatisk ga hgjere op i niveau til sit maksimum, hvorefter fglgende besked vil fremkomme pa skeermen:

No patient response g |

[0) Stop test,retry frequency or continue?

Retry Ignore

Afhaengig af omstaendighederne kan operatgren vaelge enten at afbryde testen, genteste frekvensen, ignorere fejlen
og ga videre til naeste frekvens.

For enkelt-frekvens-tests vil tonen ogsa tiltagende stige | niveau, hvorefter den stopper testen og fglgende besked vil
fremkomme pa skarmen:
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-
No patient response ® @

\o Stop test or retry frequency?

Cancel

Afhaegig af omstaendighederne kan man vaelge enten af genteste den aktuelle frekvens eller slette testen.

Check at patienten forstar instruktionerne i at give respons via knappen. Check ogsa at patientsvareren er tilsluttet og
at der kommer output ud af apparatet.

6.4. RESPONS-KNAP HOLDT NEDE

Hvis audiometer detekterer et respons fra patientsvareen, som ikke var givet af patienten selv, vil testen ga ned |
lydniveau og testen vil ga i pause-mode, med fglgende besked pa skeermen:

Response switch held on! [ﬂ

7~ .
'@" Stop test,retry frequency or continue?

Retry Ignore

Afhaengig af omstandighederne kan operatgren vaelge enten at afbryde testen, genteste frekvensen, ignorere fejlen
og ga videre til naeste frekvens.

For enkelt-frekvens-tests vil tonen ogsa tiltagende stige | niveau, hvorefter den stopper testen og fglgende besked vil
fremkomme pa skarmen:

- =
Response switch held on!

Cancel

Afhaengig af omstaendighederne kan operatgren vaelge enten at afbryde testen, genteste frekvensen, ignorere fejlen
og ga videre til naeste frekvens.

Check at patienten forstar instruktionerne i at give respons via knappen. Check ogsa at patientsvareren er tilsluttet og
at der kommer output ud af apparatet.
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6.5. SPORADISK PATIENT RESPONS

Hvis patienten ikke er konsistent i responderingen pa den automatiske test vil det ikke vaere muligt at bestemme
hgretaerskelsvaerdier. Afhaengig af testopsaetningen vil testen enten blive sat pa pause eller hoppe til den naste
testfrekvens. Hvis Pause vaelge fremkommer fglgende besked pa skeermen:

-
Threshold not found l""‘;’-"l

:‘,l Stop test, retry frequency or continue?

Retry Ignore

'j Venligst notér: Denne besked vises ikke for en “enkelt frekvens test”, men hvis en komplet test afsluttes
indeholdende fejl. (Se herunder).

Hvis audiometeret formar at fastsla nogle hgretzaerskelsvaerdier via den automatiske test, men ikke alle, fremkommer
folgende dialog boks pa skeermen:

& A
Automatic Test Finished ﬂ

Test sequence complete with emars
Continue further testing, or accept results?

Dette alarmerer operatgren omkring, at der er fejl | testen, der bgr undersgges neermere:
e Enten testes ydeligere indtil fejlene kan udbedres
e Eller at de opnaede resultater accepteres og overfgres til Audibase

6.6. EXIT OTOSURE MED INGEN RESULTATER

Hvis Otosure Softwaren lukkes uden testresultater vises den fglgende meddelelse i Audibase:

F ™
Instrument Error ﬁ

Mo results: (153)

Klik OK og brug “Edit > Cancel Insert/Edit” funktionen eller cancel toolbar knappe til at afbryde operationen.

6.7. USB KABEL IKKE TILSLUTTET

Hvis USB kablet mister forbindelsen til Otosure, afbrydes enhver test resolute, og den fglgende meddelelse vises pa
skeermen:
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r Y
Error &J

Connection lost!
Test abandoned

Hvis man anerkender beskeden er det muligt at betjene knapper og funktioner | Otosure vinduet, omend det er uden
faktisk funktione. Hvis USB forbindelsen afbrydes anbefales det at lukke Otosure vinduet og returnere til Audibase.
Brug derefter “Edit > Cancel Insert/Edit” funktionen eller cancel toolbar knappen til at fjene data og luk Audibase.
Derefter kan Otosure tilsluttes pa ny og Audibase starte pa normal vis.

Hvis Otosure vinduet er lukket, vil data blive overfgrt til Audibase. Gennemse dette data for validitet inden brug.

Se afsnit 11 for yderligere vigtig information omkring tilslutning af ikke-medicinsk udstyr til medicinsk udstyr.



VEDLIGEHOLDELSE

/.VEDLIGEHOLDELSE

7.1.

GENERELLE FREMGANGSMADER VED VEDLIGEHOLDELSE

Instrumentets ydeevne og sikkerhed vil bevares, hvis fglgende anbefalinger for pleje og vedligehold overholdes.

1.

Det tilrades at lade instrumentet gennemga mindst én arlig kontrol for at sikre, at de akustiske, elektriske og
mekaniske egenskaber er korrekte. Dette skal udfgres af et erfarent vaerksted til sikring af korrekt service og
reparation.

Pas p3, at der ikke er skader pa strgmkablets isolering eller stik, og at det ikke udszettes for nogen form for
mekanisk overlast, der kunne medfgre skader.

For at sikre at instrumentets driftsikkerhed bevares, anbefales det, at operatgren med korte intervaller, f.eks.
én gang hver dag, udfgrer en test pa en person hvis data er kendt. Denne person kunne vaere operatgren
selv.

Hvis instrumentets overflade eller dele af det er snavset, kan det renggres med en blgd klud fugtet med en
mild oplgsning af opvaskemiddel eller lignende. Tag altid lysnetstikket ud under renggring, og pas p3, at der
ikke traenger vaeske ind i instrument eller tilbehgr.

Efter undersggelsen af hver enkelt patient sikrer man sig, at der ikke er sket nogen forurening af de dele som
har bergrt patienten. Generelle foranstaltninger skal traeffes for at krydssmitte mellem patienterne. Vand kan
bruges til hyppig renggring, men i tilfaelde af alvorlig kontamination kan det vaere ngdvendigt at bruge et
desinfektionsmiddel..

Sluk og tag altid lysnetstikket ud inden renggring

Brug en blgd klud, der er let fugtet med et renggringsmiddel til at renggre alle synlige overflader
Tillad ikke vaeske at komme i kontakt med metaldelene i hovedtelefonen.

Undlad at autoklavere, sterilisere eller nedsaenke instrumentet eller tilbehgret i nogen form vaeske
Undlad at bruge harde eller spidse genstande til renggring af instrumentet eller tilbehgret

Lad ikke dele, der har veeret i kontakt med vaeske, tgrre inden renggring
Gummi-eartips eller skum-eartips kan kun anvendes én gang
S¢rg for at isopropylalkohol ikke kommer i kontakt med silikoneslanger eller gummidele

Anbefalede renggrings- og desinfektionsmidler:

7.2.

Varmt vand med et mildt, ikke slibende renggringsmiddel (saebe)
70 % isopropylalkohol kun pa harde overflader

VEDLGEHOLDELSE AF AUDIOMETER

Otosure audiometer er et praecisions maleinstrument. Det bgr behandles med forsigtighed for at bevare dets praecision.
Nar instrument renggres, fjern da fgrst netadapteren. Brug en blgd klud og et mildt renggringsmiddel for at renggre
apparatets instrumentpane. Se i gvrigt ISO 8253-1 for yderligere guidelines.
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7.3. VEDLIGEHOLDELSE AF TRANSDUCERE

For brug af transducerne, check da venligst kabler og forbindelser for at sikre at de virker som forventet. Check om der
er tegn pa brud eller anden skade, der bgr udbedres. | sa fald, kontakt Amplivox eller din Amplivox distributgr. Venligst
oplys det relevante varenummer.

Handtér audiometri headset og andre accessories med forsigtighed. For dele, der er i direkte kontakt med patienten,
anbefales det, at der benyttes de standarder, der anvendes i det pagaldende miljg for renggring, saledes at smitterisiko
imellem patienter nedbringes til et minimum.

' OBS: pas pa at fugt ikke traenger ind | hovedtelefonerne ved renggring.

7.4. TILBEH@R OG RESERVEDELE

Nogle del-komponenter vil veere ngdvendige at udskifte i Igbet af apparatets levetid. Vi anbefaler at der tages kontakt
til Amplivox eller dennes repraesentant i det pageeldende land for at fa originale dele til apparatet.

7.5. OM REPARATIONER

Amplivox Ltd. anses kun at vaere ansvarlig for CE-maerkningens gyldighed, pavirkninger af sikkerhed, palidelighed og
udstyrets ydeevne safremt:

e samleprocesser, tilfgjelser, efterreguleringer, &endringer eller reparationer udfgres af autoriserede personer,

e 1 arsserviceinterval bevares

o de elektriske installationer i det aktuelle lokale lever op til de relevante krav, og

e udstyret bruges af autoriseret personale i overensstemmelse med den dokumentation Amplivox Ltd. har
leveret.

Det er vigtigt, at kunden (agenten) udfylder RETURNERINGSRAPPORT-formularen, hver gang et problem opstar. Dette
bgr ogsa ggres hver gang et instrument returneres til Amplivox Ltd.. (Dette geelder naturligvis ogsa i det usandsynlige,
veerst teenkelige tilfeelde af dgdsfald eller alvorlige tilskadekomst for patient eller bruger).

Amplivox Limited

3800 Parkside, Solihull Parkway,
Birmingham Business Park,
Birmingham, West Midlands,
B37 7YG

United Kingdom
hello@amplivox.com

Dette skal ogsa udfgres, safremt apparatet skal retur til Amplivox Ltd. (Dette geelder naturligvis ogsa i det uforlignelige
tilfeelde, at der er tale om worst case scenarios sdsom dgdsfald eller sveere skader pa patient eller operatgr).

Venligst benyt den originale forsendelsesemballage inkl. pakkemateriale, hvis instrumetet eks. skal sendes til kalibrering
eller reparation.

7.6.  GARANTI

Alle Amplivox instrumenter er garanteret mod defekte materialer og fejl i fremstillingen. Instrumentet vil blive repareret
gratis, 3 ar fra afsendelsesdatoen, hvis instrumentet er blevet returneret, med betalt forsendelse, til Amplivox
serviceafdeling. Returnering er gratis for kunder i Storbritannien, men betales af oversgiske kunder.
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Med folgende undtagelser:

Advarsel e  Hvis trykpumpen og transduceren efter hardhandet behandling eller stgd
(tab), mister deres kalibrering.

e Holdbarheden for malesonde, sondeforsegling og grepropper afhaenger af,
hvordan de bruges. Disse dele er kun garanteret mod defekte materialer
eller fejl i fremstillingen.

Hvis et produkt skal serviceres i den geeldende garantiperiode, skal kgberen kommunikere direkte med det lokale
Amplivox Ltd. servicecenter og fa anvist et egnet reparationssted. Reparation eller udskiftning udfgres pa Amplivox Ltd.’
regning i overensstemmelse med bestemmelserne i denne garanti. Produktet, der kreever service, skal straks returneres
behgrigt pakket med post eller fragt forudbetalt. Tab eller skader opstaet under tilbagesendelse til Amplivox Ltd. er pa
kgbers risiko.

Under ingen omstaendigheder er Amplivox Ltd. ansvarlig for nogen uforudset, indirekte eller fglgeskade i forbindelse
med kgb eller brug af Amplivox Ltd. produkter.

Ovenstaende gaelder udelukkende for den oprindelige, f@rste kgber. Denne garanti gaelder ikke for nogen efterfglgende
ejer eller indehaver af produktet. Desuden gaelder denne garanti ikke for, og Amplivox Ltd. er ikke ansvarlig for, tab, der
opstar i forbindelse med kgb eller brug af ethvert Amplivox Ltd. produkt, der:

er blevet repareret af andre end det autoriserede Amplivox Ltd. servicevaerksted
er blevet aendret pa nogen made, som, efter Amplivox Ltd. bedgmmelse, kan pavirke dets stabilitet eller palidelighed

har veeret genstand for misbrug eller forsgmmelse eller ulykke, eller har faet serie- eller partinummeret andret,
udvisket eller fiernet, eller

er blevet forkert vedligeholdt eller anvendt pad nogen anden made end i overensstemmelse med Amplivox Ltd.
anvisninger

Denne garanti treeder i stedet for alle andre garantier, udtrykkelige eller underforstaede, og alle andre forpligtelser for
Amplivox Ltd.. Amplivox Ltd. hverken giver eller tildeler, direkte eller inddirekte ret til at nogen repraesentant eller anden
person pa vegne af Amplivox Ltd. kan patage sig nogen anden forpligtelse i forbindelse med salg af Amplivox Ltd.-
produkter.

AMPLIVOX LTD. FRASKRIVER SIG ALLE ANDRE UDTRYKKELIGE ELLER INDIREKTE GARANTIER, HERUNDER ENHVER
GARANTI OM SALGBARHED ELLER EGNET FUNKTION TIL ET GIVET FORMAL.



7.7. KALIBRERING OG RETURNERING AF INSTRUMENT

Amplivox anbefaler arlig kalibreing af Otosure.

Kontakt venligst Amplivox eller den lokale forhandler for detaljer omkring kalibreringsservice.

7.8. GARANTI

Alle Amplivox instrumenter er garanteret mod defekte materialer og fejl i fremstillingen. Instrumentet vil blive repareret
gratis, 3 ar fra afsendelsesdatoen, hvis instrumentet er blevet returneret, med betalt forsendelse, til Amplivox
serviceafdeling. Returnering er gratis for kunder i Storbritannien, men betales af oversgiske kunder.

' Venglist noter: Med fglgende undtagelser;

Hovedtelefonerne er szerligt udsatte, da de via slag eller grov handtering (fald pa gulv) kan “komme ud af” kalibrering.
Det same geelder kabler pa hovedsaet mm. Disses holdbarhed afhaenger af brugsmgnster. Derfor geelder garanti af
disse produktdele kun vedr. fejl i materialer og produktionsfejl af producenten
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8. TEKNISKE SPECIFIKATIONER

8.1. STANDARDER OG MYNDIGHEDSKRAV

Otosure Audiometeret imgdekommer kravene fra fglgende standarder:

e BS/EN/IEC 60601-1: Medical Electrical Equipment — General requirements for basic safety and essential
performance

e BS/EN/IEC 60601-1-2: Medical Electrical Equipment — Electromagnetic Compatibility: Requirements and Tests

e BS/EN/IEC 60645-1: Electroacoustics — Audiological Equipment — Partl: Pure-tone Audiometers

Type af beskyttelse mod elektrisk stgd: Powered via SELV Class Il netadapter
Grad af beskyttelse mod elektrisk stgd: Type B anvendt del

Grad af beskyttelse mod indtreengen af vand: Ikke beskyttet

Funktionsmade: Baerbar

Otosure er klassificeret som en klasse lla enhed under bilag VIII (afsnit 1), i EU’s regulering omkring medicinsk udstyr.

8.2. INPUT/OUTPUT

Forbindelse til PC: USB (version 1.0 or 2.0); type B connector
Venstre & Hgjre outputs: 6.3mm Jack stik
Patient Response Switch: 6.3mm Jack stik

Maximum voltage at any output: 5V peak

8.3. AUDIOMETRIC

Audiometer type: Type 4 (IEC 60645-1:2001 & ANSI S3.6:2004)

Frekvensomrade: 125Hz, 250Hz, 500Hz, 1kHz, 1.5kHz, 2kHz, 3kHz, 4kHz, 6kHz, 8kHz
Frekvenspraecision: <1%

Forvraengning: <2%

Intensitetsomrade: -10dB — 100dBHL (80dBHL ved 125Hz)

Intensitetstrin: 5dB

Intensitet praecision: Indenfor 3dB

Headset statisk belastning: 4.5N

8.4. EGENSKABER FOR LYDDZAMPNING AF @RETELEFONER

Frekvens, Hz 125 250 500 1000 2000 4000 8000
Dzempning, dB 2 5 7 15 25 31 23

8.5. FYSISKMIL@ & OMGIVELSER

Dimensioner: 120mm (L) x 85mm (W) x 30mm (H)
Vaegt: 150gm

Driftsmiljg temperatur: +15°C to +35°C

Temperatur (opbevaring/transport): -20°C to +70°C

Luftfugtighed (driftsmiljg): 30% - 90% (ikke kondenserende)
Luftfugtighed(opbevaring/transport): 10% - 90% (ikke kondenserende)
Omgivelsestrykk (driftsmiljg): 700hPa - 1060hPa
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TEKNISKE SPECIFIKATIONER

Omgivelsestryk Pressure 500hPa - 1060hPa
(opbevaring/transport):
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9.EMC VEJLEDNING OG PRODUCENTENS ERKLARING

Vejledning og producentens erklzering — elektromagnetisk straling

Otosure er beregnet til brug i elektromagnetiske omgivelser specificerede herunder. Kunden eller brugeren af Otosure bgr
sikre, at den bruges i sddanne omgivelser.
Stralingstest

Overens-stemmelse Elektromagnetiske omgivelser— vejledning

RF-strdling Gruppe 1 Otosure bruger kun RF-energi til interne funktioner.

Dets RF-straling er derfor meget lav og burde ikke
forarsage interferens med andet elektronisk udstyr i
CISPR 11 nzrheden.

RF-straling

Klasse B Otosure er egnet til brug i alle bygninger, herunder
private bygninger og bygninger med direkte tilkobling
til den offentlige forsyning af lavspaendingsstrgm, til
CISPR 11 private bygninger.

Harmonisk straling

Ikke relevant

IEC 61000-3-2
Udsving i den elektriske spaending/

Ikke relevant

flickeremissioner

IEC 61000-3-3

Vejledning og producentens erklaering — elektromagnetisk spanding (1)

Otosure er beregnet til brug i elektromagnetiske omgivelser specificerede herunder. Kunden eller brugeren af Otosure bgr
sikre at den bruges i sddanne omgivelser

Spandingstest IEC 60601 testniveau Overens-stemmelses- | Elektromagnetiske omgivelser —
niveau vejledning
Elektrostatisk 16 kV kontakt 16 kV kontakt Gulve bor veere af tree, beton
udladning ESD) eller keramikfliser. Hvis gulve er
belagt med syntetiske materialer,
+8 kV luft +8 kV luft bgr den relative luftfugtighed
vaere mindst 30 %.
IEC 61000-4-2
Hurtige elektriske | +2 kv for | lkke relevant Ikke relevant
overspandinger/strgmstgd strgmforsyninger
IEC 61000-4-4 +1 kv for
indgangs/udgangs
ledninger
Overspaending +1 kV differential | Ikke relevant Ikke relevant
IEC 61000-4-5 spending

2 kV  almindelig
spaending
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Spaendingstest

IEC 60601 testniveau

Overens-
stemmelses-niveau

Elektromagnetiske omgivelser —
vejledning

Spaendingsfald, korte <5%UT Ikke relevant Ikke relevant
afbrydelser og (>95 % fald i UT)
spaendings-udsving i 0,5 periode
i strgmforsynings
ledninger 40 % UT
(60 % fald i UT)
IEC 61000-4-11 |5 perioder
70 % UT
(30 % fald i UT)
i 25 perioder
<5%UT
(>95 % fald i UT)
i 5 sek.
Strgmfrekvens 3A/m 3A/m Stregmfrekvensen i magnetfelter
(50/60 Hz) bgr vaere pa samme niveau, som
magnetfelt er normal for et typisk erhvervs-
eller hospitalsmiljg
IEC 61000-4-8

BEMZRK at Ut er netspaendingen, fgr testniveauet

4 OTOSURE BRUGSANVISING
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Vejledning og producentens erklaering — elektromagnetisk spanding (2)

Otosure er beregnet til brug i elektromagnetiske omgivelser specificerede herunder. Kunden eller brugeren af
Otosure bgr sikre at den bruges i sddanne omgivelser

Spandingstest IEC 60601 Overensstemmelsesniveau Elektromagnetiske omgivelser—
testniveau vejledning
Baerbart og mobilt RF-

kommunikationsudstyr bgr ikke bruges
tettere pa nogen dele af Otosure,
herunder kabler, end den anbefalede
minimumsafstand som er beregnet ud
fra den ligning, der geelder for senderens
frekvens

Anbefalet minimumsafstand

d = 1.2VP 80MHz til 800MHz

Udstraling af RF 3V/m 3V/m
IEC 61000-4-3 80MHz to d = 2.3VvP 800MHz til 2.5GHz
2.5GHz

hvor P er senderens maksimale
nominelle udgangseffekt i watt (W)
i felge producenten af senderen, og d er
den anbefalede

minimumsafstand i meter (m).

Feltstyrker fra faste RF-sendere,
bestemt ved en elektromagnetisk
maling pa stedet, ® bgr ligge under
overensstemmelsesniveauet i hvert
frekvensomrade. ®

Der kan forekomme interferens i
naerheden af udstyr, der er maerket
med fglgende symbol:

(« H )

BEMZRKNING 1 Ved 80 MHz og 800 MHz gaelder det hgjeste frekvensomrade.

BEMZRKNING 2 Der kan veere situationer, hvor disse retningslinjer ikke geelder. Elektromagnetisk stralingsspredning
pavirkes af absorption og refleksion fra bygninger, genstande og personer.
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Vejledning og producentens erklaering — elektromagnetisk spanding (2)

a Feltstyrker fra faste sendere, sasom ladestationer til mobiltelefoner, tradlgse telefoner og mobilradioer,
amatgrradioer, AM- og FM-radioudsendelser og tv-udsendelser, kan ikke i teorien forudsiges ngjagtigt. For at
vurdere det elektromagnetiske omrade, som faste RF-sendere forarsager, bgr man overveje at foretage en
elektromagnetisk undersggelse. Hvis den malte feltstyrke, pa det sted hvor Otosure anvendes overstiger det
gaeldende RFoverensstemmelsesniveau som angivet ovenfor, bgr Otosure overvages ngje for at kontrollere, at
det fungerer normalt. Hvis instrumentet ikke fungerer normalt, bgr der tages yderligere forholdsregler, sa som at
flytte Otosure, eller anbringe det, sa det vender i en anden retning.

b | frekvensomradet fra 150 kHz til 80 MHz bgr feltstyrkerne vaere under 3 V/m

Anbefalet sikkerhedsafstand mellem

barbart og mobilt RF-kommunikationsudstyr og Otosure

Otosure er beregnet til brug i et elektromagnetisk miljg, hvor der kontrolleres for udstralede RF-forstyrrelser. Kunden, eller
brugeren af Otosure, kan hjelpe med at forhindre elektromagnetisk interferens, ved at opretholde en minimumsafstand
mellem baerbart eller mobilt radiokommunikationsudstyr (sendere) og Otosure som anbefalet nedenfor, i henhold til

kommunikationsudstyrets maksimale udgangseffekt.

Senderens nominelle Sikkerhedsafstand ifglge senderens frekvens
maksimale udgangseffekt
m
w 150 kHz to 80 MHz 80 MHz to 800 MHz 150 kHz to 80 MHz
d=1,2vP d=1.2vP d=1,2vP
0.01 0.12 0.12 0.23
0.1 0.38 0.38 0.73
1 1.2 1.2 2.3
10 3.8 3.8 7.3
100 12 12 23

For sendere med maksimal udgangseffekt, der ikke er angivet ovenfor, kan den anbefalede sikkerhedsafstand d i
meter (m) bestemmes ved hjalp af den relevante formel for senderens frekvens, hvor P er senderens nominelle
maksimale udgangseffekt i watt (W), ifglge producenten af senderen.

BEMZRKNING 1 Ved 80 MHz og 800 MHz gaelder sikkerhedsafstanden for det hgjeste frekvensomrade.

BEM/ZRKNING 2 Der kan veere situationer, hvor disse retningslinjer ikke geelder. Elektromagnetisk stralingsspredning
pavirkes af absorption og refleksion fra bygninger, genstande og personer.
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10. BRUG MED IKKE-MEDICINSK ELEKTRISK UDSTYR

Enhver person der tilslutter eksternt udstyr til signal input, signal output eller andre forbindelser, der skaber et
medicinsk elektrisk system, er ansvarlig for systemet i henhold til kravene punkt 16 i IEC 60601-1:2005 (Generelle krav
til grundleeggende sikkerhed og veesentlig ydeevne).

Hvis man foretager forbindelse til standardudstyr, sa som printere og computere, ma man tage specielle forholdsregler,
for at kunne overholde den medicinske sikkerhed. Fglgende bemaerkninger tilbydes som vejledning, nar man foretager
sadanne forbindelser for at sikre, at man overholder de generelle krav i punkt 16 i IEC 60601-1:2005.

De fglgende signal input og output enheder, passende til Otosure audiometer, er elektrisk isoleret fra instrumentet iht.
kravene fra IEC 60601-1 for at reducere potentielle farer associeret med brug af udstyr, der er tilsluttet en netadapter,
tilsluttet disse input / output enheder:

Enhed Stik Type Typisk
Forbindelse

.%. USB Connector | Computer

Eksternt udstyr til brug for forbindelse til signal input, signal output eller andre forbindelser, skal overholde de relevante
IEC eller internationale standarder (dvs. IEC 60950, CISPR 22 & CISPR 24 for IT-udstyr, og IEC 60601 serien for medicinsk
elektrisk udstyr).

Udstyr der ikke overholder IEC 60601 skal holdes uden for patienters reekkevidde, som defineret i IEC 60601-1:2005
(mindst 1,5m fra patienten).

Den der betjener udstyret ma ikke bergre tilsluttet udstyr og patienten pa samme tid, da dette udggr en uacceptabel
fare.

Se diagrammerne 1 til 3 herunder for almindelige konfigurationer for tilsluttet udstyr.

Vi henviser til Amplivox Limited pa adressen pa forsiden af denne betjeningsvejledning ved brug for rad omkring brugen
af tilsluttet udstyr.

Diagram 1: Otosure anvendt med en PC via USB forbindelse

Otosure

Netstik Adapter PC
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